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The GawacWin 1.0 Program has been developed to provide engineers with a rapid and efficient tool to conduct the stability analysis of gabion
retaining walls. The program allows the check under a large number of different situations (geometry, surcharge loads, etc.) which may occur 
during the design process. The program uses the Limit Equilibrium and the theories of Rankine, Coulomb, Meyerhof, Hansen and Bishop 
(optimized through the Simplex Minimizer Algorithm) to check the global stability of the soil/structure. The program requires the user to provide 
the problem data and perform the analysis commands .  Following this process, the program will print a report containing the problem data and 
the analysis results.

The mechanical characteristics of gabions manufactured by the MACCAFERRI Group are taken into consideration by the program; therefore the 
results of the calculation will not be realistic in the case of using other types of materials.

To facilitate and improve the comprehension of the program, it has been provided with a graphic interface integrated with a pull down menu and 
tool bar, which allows the user to check the results of the data input in a simple and direct way.  With the graphic interface it is always possible to 
check the cross section of the wall, the uphill soil geometry, the foundation, and the external surcharge loads.  Using either the View menu 
commands or the tool bar, the view can be enlarged, decreased, and moved.  In addition, the user may edit the geometry using the mouse like in 
a CAD program.

The programs main calculation hypothesis considers the problem to have a planar configuration, requiring only the cross section dimensions for 
the analysis.  In such a hypothesis the effects caused by variations in the loads or in the soil geometry in the direction perpendicular to the plane 
are neglected. On the other hand, an analysis of the problem which takes into account the above effects would be more complete, but it would 
also make the calculation, and the data required to describe the problem, more complex.  Experience proves that except in particular cases, the 
analysis of plane surfaces with respect to three-dimensional ones provides more conservative results thus a higher factor of safety.

The theories mentioned above have some limitations regarding their use in special situations. In such cases, since the program is able to deal 
with a huge variety of situations, the user may choose to perform complementary comparisons and analysis to overcome these limitations.  For 
such situations, it is recommend the user contact the MACCAFERRI Technical Department for assistance.

7. General



3

GawacWinGawacWin ®

The following four Submenu options appear under the Main menu option Wall.  Each option refers to geometric characteristics for gabion walls.

8.1 Characteristics of materials
GABIONS

The submenu Set Up allows the user to input the general characteristics 
about the wall.  The Add Layer option allows the user to input the data for 
each gabion layer of the wall.  The Edit and Remove options permit the 
user to modify the data about particular layers of the wall.  The program 
numbers the layers starting from the bottom to the top of the wall.  

The submenu Set Up allows the user to input the general characteristics 
about the wall.  The Add Layer option allows the user to input the data for 
each gabion layer of the wall.  The Edit and Remove options permit the 
user to modify the data about particular layers of the wall.  The program 
numbers the layers starting from the bottom to the top of the wall.  

The gabion is a structure made of 8x10 hexagonal double twisted wire mesh type. Gabions are
filled with stones at the project site to form flexible, permeable, monolithic structures such as
retaining walls, channel linings, and weirs for erosion control projects.  For typical retaining
tructures, box type gabions are used however in cases where the structure is either partially or 
totally submerged or even supported on low bearing capacity soil, sack gabions are sometimes 
used on the lower layers.

8. Data about the wall
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Box gabions are elements in a rectangular shape that are divided into cells by means of diaphragms positioned at approximately 3-ft 
centers during the manufacturing process. Box gabion standard dimensions are detailed as following:

The standard dimensions of sack gabions are shown on the table: →

Sack gabions are cylindrical shaped elements which are normally filled before they are placed at the site. 

SACK GABIONS

8. Data about the wall

Length (m) Width (m) Height (m) Volum (m3) Diaphragn
1.50 1.00 0.50 0.75 -
2.00 1.00 0.50 1.00 1
3.00 1.00 0.50 1.50 2
4.00 1.00 0.50 2.00 3
5.00 1.50 0.50 3.75 4

1.50 1.00 1.00 1.50 -
2.00 1.00 1.00 2.00 1
3.00 1.00 1.00 3.00 2
4.00 1.00 1.00 4.00 3
5.00 1.50 1.00 7.50 4

Box Gabions With Diaphragn

Diafragma

continue
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SACK GABIONS

The standard dimensions of sack gabions are shown on the table.

Box and sack gabions are manufactured from panels of hexagonal double twisted mesh, type 8 x 10 (ASTM A975-97), which is manufactured 
from soft temper steel wires.

The wire used in box and sack gabion manufacturing are coated with either a heavy zinc coating or GALMAC(*) binding = zinc/5% aluminum -
(ASTM 856 and ABNT 8964), with a minimum mass of 240 g/m2 of wire surface. The wires may also have a supplemental coating of PVC
(ABNT 10.514), which is extruded with a minimum thickness of 0.4 mm.

In the sack gabion manufacturing process only PVC coated wires are used since these elements are always in contact with aggressive 
chemical environments.

Box and sack gabions are manufactured from panels of hexagonal double twisted mesh, type 8 x 10 (ASTM A975-97), which is manufactured 
from soft temper steel wires.

The wire used in box and sack gabion manufacturing are coated with either a heavy zinc coating or GALMAC(*) binding = zinc/5% aluminum -
(ASTM 856 and ABNT 8964), with a minimum mass of 240 g/m2 of wire surface. The wires may also have a supplemental coating of PVC
(ABNT 10.514), which is extruded with a minimum thickness of 0.4 mm.

In the sack gabion manufacturing process only PVC coated wires are used since these elements are always in contact with aggressive 
chemical environments.

8. Data about the wall

Lenght (m) Diameter (m) Volum (m3)

2.00 0.65 0.66
3.00 0.65 1.00
4.00 0.65 1.33
5.00 0.65 1.66

Sac Gabions
Dimentions



6

GawacWinGawacWin ®

8.2 Dimensions of gabions layers

The dimensions of each gabion layer are input under the Wall menu in the SetUp window in the Layers folder as shown:

8. Data about the wall

continue
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Width: Horizontal dimension of gabions layers (disregard the wall inclination).
Height: Vertical dimension of gabions layers (disregard the wall inclination).
Offset: The horizontal distance (disregard the wall inclination) between the left face of the gabion layer and the left face of the base

layer.

The dimensions to be specified in each field are:

8.2 Dimensions of gabions layers

8. Data about the wall
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This pull down menu allows the user to clarify the type 
of mesh and the wire used on the gabions.The user 
must choose between the two 'standard types'  
produced by MACCAFERRI and used for gabion
products.The keys < up > and < down > show the 
available types.

This pull down menu allows the user to clarify the type 
of mesh and the wire used on the gabions.The user 
must choose between the two 'standard types'  
produced by MACCAFERRI and used for gabion
products.The keys < up > and < down > show the 
available types.

8.3 The mesh and the wire diameter

Box and sack gabions are manufactured from panels of hexagonal double twisted mesh, type 8 x 10 (ASTM A975-97), which is manufactured 
from soft temper steel wires.

The wire used in box and sack gabion manufacturing are coated with either a heavy zinc coating or GALMAC(*) binding = zinc/5% aluminum
- (ASTM 856 and ABNT 8964),   with a minimum mass of 240 g/m2 of wire surface. The wires may also have a supplemental coating of PVC
(ABNT 10.514), which is extruded with a minimum thickness of 0.4 mm.

In the sack gabion manufacturing process only PVC coated wires are used since these elements are always in contact with aggressive
chemical environments.

Box and sack gabions are manufactured from panels of hexagonal double twisted mesh, type 8 x 10 (ASTM A975-97), which is manufactured 
from soft temper steel wires.

The wire used in box and sack gabion manufacturing are coated with either a heavy zinc coating or GALMAC(*) binding = zinc/5% aluminum
- (ASTM 856 and ABNT 8964),   with a minimum mass of 240 g/m2 of wire surface. The wires may also have a supplemental coating of PVC
(ABNT 10.514), which is extruded with a minimum thickness of 0.4 mm.

In the sack gabion manufacturing process only PVC coated wires are used since these elements are always in contact with aggressive
chemical environments.

8. Data about the wall
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When a geotextile is to be placed between the wall base and The 
foundation the user must select this option.  The program Will 
consider the reduction in friction (in percent) as specified by the 
user.  In general this reduction is taken to be 10%.

When a geotextile is to be placed between the wall base and The 
foundation the user must select this option.  The program Will 
consider the reduction in friction (in percent) as specified by the 
user.  In general this reduction is taken to be 10%.

8.4 Geotextile under the base

8. Data about the wall
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From the Wall menu, the general inpu
data section (Set up...), is compounded of 
two folders: 

a)”General”

From the Wall menu, the general inpu
data section (Set up...), is compounded of 
two folders: 

a)”General”

8.5 General data about the wall

In this folder, the following data is 
provided:

•Wall batter
•Rockfill unit weight
•Gabions porosity
•Geotextile in the backfill
•Geotextile on the base
•Mesh and the wire diameter
•Aggressive environment

In this folder, the following data is 
provided:

•Wall batter
•Rockfill unit weight
•Gabions porosity
•Geotextile in the backfill
•Geotextile on the base
•Mesh and the wire diameter
•Aggressive environment

8. Data about the wall

continue
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Width: Width of the gabion layer.
Height: Height of the gabion layer.
Offset: The distance parallel to the base of the wall between the external face (left-side) of the first layer and the external face of the

additional gabion layers (not required for the first gabion layer).

8.5 General data about the wall

In this folder, the dimensions of each 
layer in the wall are provided. These 
dimensions include: 

In this folder, the dimensions of each 
layer in the wall are provided. These 
dimensions include: 

b)  ”Layers"

8. Data about the wall

continue
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Observations:

Due to the commercial patterns developed in the production of Gabions, the width of the layers should be given in multiples of 0.5 meter or 1.5 
feet. 

Using the graphic interface implemented in this version, the alterations described above can also be performed directly on screen using the 
mouse.

--------Add a layer on the top of the wall.
-------------Add a layer following the one selected.
-------------Delete the layer selected.

------------------Modify the size of the selected gabion layer..
-------------------Modify the size of all gabions layers.

Those data are edited on the edition table. Initially only the first line on the table is shown, corresponding to the base dimensions.    To change
this field press the ENTER key. When the last column of last line is gotten, a new layer of gabions will come to sight automatically by pressing
the ENTER key.

Besides, the mouse right button can be used to open a screen menu with the following commands:

8.5 General data about the wall

8. Data about the wall
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Observations: 
Due to the commercial patterns developed in the production of Gabions, the width of the layers should be given in multiples of 0.5 meter or 
1.5 feet.  Using the graphic interface implemented in this version, the alterations described above can also be performed directly on screen
using the mouse..

8.6 Wall batter

Wall batterWall batter

To alter the wall batter, move the 
grip to the desired direction.

Wall batter indicates the clockwise inclination for gabions walls from the verticle face. The angle given must always be positive and is normally
between 0 and 10 degrees.

8. Data about the wall
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8.7 Rockfill unit weight
Rockfill unit weight indicates weight specific value at the current unity, the fill material that 
compounds the stone used to fill the gabions (Filling material).

8.8 Porosity of gabions
Porosity of the gabion indicates the value in 
percentage of the filling material porosity. The 
porosity is defined as material void volume divided 
by its total volume. GawacWin uses this value to
calculate the structure proper weight of the 
gabions..

8.9 Geotextile on the backfill
When a geotextile is to be placed between the wall and the backfill the user must select this option.  
The program will consider the reduction in friction (in percent) as specified by the user.  In general 
this reduction is taken to be 10%. 

8. Data about the wall
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The Backfill submenu allows the user to input all data relevant to the soil behind the wall and above the base including soil profiles and soil 
characteristics. The GawacWin program is able to analyse more than one type of compacted soil layers, both parrallel and not parallel.  It is 
also possible to take into account the presence of an underground water table (a phreatic surface) in the backfill. The presence of water will
cause the thrust to rise due to water percolation. The submenu options are:

9. Backfill
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The Backfill general data (Set up...) are separate in two groups :

Soil profile

Under this heading, the geometrical characteristics of the backfill soil profile supported by the gabion wall are input. By selecting this option a 
window with the following data field will appear:

1st slope: The counterclockwise inclination of the first uphill soil stretch.
1st length: The horizontal length of the first uphill soil stretch. If this data field is not filled in with a numerical value, this soil stretch will 

extend indefinitely to the right.
2nd slope: The inclination of the second uphill soil stretch. If no value is provided this soil surface will extend indefinitely to the right starting

from the point of termination of the first uphill soil surface. If the data field relevant to the first layer is not filled in, this field will be
ignored.

9.1 Backfill data

9. Backfill

continue
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Soil Properties
In this group the data of the main soil that composes the backfill are provided. If the backfill is constituted by layers of different soils, these are
the properties of the soil that it forms the top surface. The required data are:  

Unit weight: The unit weight of the soil surface immediately below the uphill soil profile touching the retaining wall
Friction angle: The internal friction angle of the soil surface below the uphill soil profile.
Cohesion: The cohesion of the soil surface below the uphill soil profile touching the retaining wall.

9.1 Backfill data

9. Backfill
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9.2 Data of the backfill layers

Once the option Add layer... has been entered, the user is required to type in all data about the layer to be added. The backfill layers data are
separate in two groups.

Geometry of the layer
In this group, the geometrical characteristics of the surface of the top layer are entered: 

Initial height: The vertical distance between the wall base and
the layer interface. The program will not 
consider two layers having the same height.

Inclination: The counterclockwise inclination of the soil layer
interface.

Initial height: The vertical distance between the wall base and
the layer interface. The program will not 
consider two layers having the same height.

Inclination: The counterclockwise inclination of the soil layer
interface.

Soil Properties

In this group soil data which form the layer are provided:

Unit weight: Unit weight of the soil layer below the specified interface.
Friction angle: Value of the internal friction angle of the additional soil 
layer.
Cohesion: Cohesion of the soil layer below the specified interface.

9. Backfill



1
9

GawacWinGawacWin ®

Gabions require a filling material thats weight and characteristics satisfy the static requirements, are functional, and are struturally durable.

The most commonly used fill are from stone-quarries or river beds. Since gabions are used for mass gravity structures, the materials must 
have a high specific weight. Materials used for filling gabions must always be no friable, non-washable, and non-porous.

The following table shows weigths indicated for several types of rock.

The material granulometry must be between one and two times the mesh dimension "D", in 
order to avoid the material escaping the mesh and therfore provide a uniform specific weight of 
the structure.

The material granulometry must be between one and two times the mesh dimension "D", in 
order to avoid the material escaping the mesh and therfore provide a uniform specific weight of 
the structure.

9.3 Filling material

9. Backfill

Type of Rock Density (Ton/m3)

Basalt 2.9

Granite 2.6

Hard Limestone 2.6

Trachytes 2.5

Sandstone 2.3

Soft Limestone 2.2

Tuff 1.7
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The gabion structures proper weight is based on the designed wall section and the Filling material specific weight.

Where: γg is the gabions specific weight, γp is the stones specific weight which fill the gabions (Filling material) and η the porosity (index of voids).

The proper weight of the gabions structures can vary depending on the kind of Filling material and/or work situation. When the structure is partially 
submerged, a submerged specific weight is used to calculate the structure proper weight. This specific weight is used only for part of the wall that 
is under the water level and its value is : 

Where γg is the gabion specific weight, γgsat is the saturate specific weight of gabions, γa is the water specific weight, γp is the specific weight 
of stones which fill the gabions (Filling material) and η is the porosity (index of voids).

9.4 Proper weight of gabions structures

9. Backfill
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Phreatic surfaces can be specified inside the backfill. This surface can be either horizontal, indicating 
ground water or in a simulated curve, indicating the occurance of water fluxes toward  the wall. In this
case the phreatic surface is close to three straight segments, the last one horizontal. 
By selecting this option the user will enter the following data field:

Phreatic surfaces can be specified inside the backfill. This surface can be either horizontal, indicating 
ground water or in a simulated curve, indicating the occurance of water fluxes toward  the wall. In this
case the phreatic surface is close to three straight segments, the last one horizontal. 
By selecting this option the user will enter the following data field:

Initial height: The distance between the water table and the base of the wall.
1st slope: The counterclockwise inclination of the first segment of the phreatic surface;
1st length: The horizontal length of the first reach of the phreatic surface. If this value is not provided, the phreatic surface will extend 

indefinitely to the right end side of the screen. In this case it will not be necessary to provide the subsequent data.
2nd slope: The counterclockwise inclination of the second segment of the phreatic surface;
2nd length: The horizontal length of the second reach of the phreatic surface. If this field is not filled in the phreatic surface will extend 

indefinitely to the right with an inclination provided on the previous data field and therefore there won't be a third reach.

Initial height: The distance between the water table and the base of the wall.
1st slope: The counterclockwise inclination of the first segment of the phreatic surface;
1st length: The horizontal length of the first reach of the phreatic surface. If this value is not provided, the phreatic surface will extend 

indefinitely to the right end side of the screen. In this case it will not be necessary to provide the subsequent data.
2nd slope: The counterclockwise inclination of the second segment of the phreatic surface;
2nd length: The horizontal length of the second reach of the phreatic surface. If this field is not filled in the phreatic surface will extend 

indefinitely to the right with an inclination provided on the previous data field and therefore there won't be a third reach.

9.5 Phreatic surface

The program will plot a third reach 
which will extend indefinitely to the 
right, starting from where the 
second stretch ends. If the 
presence of  the phreatic surface 
is not considered, the above data 
field will not be filled in.

The program will plot a third reach 
which will extend indefinitely to the 
right, starting from where the 
second stretch ends. If the 
presence of  the phreatic surface 
is not considered, the above data 
field will not be filled in.

9. Backfill
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The foundation soil considered by the program is the soil below the wall foundation, including the downhill soil layer touching the left edge of the
wall base and the soil behind the retaining wall.

10.1 Foundation data

The foundation may consist of a maximum of three different soil layers. The program considers these layers as horizontal planes.
For each layer the user shall provide the depth (Initial height) of the soil interface and the physical characteristics of the soil layer below it.

The foundation general data (Foundation set up...) are separated in three groups:

Soil profile
The geometric characteristics of the soil profile to the left of the gabion wall are input in the following group:

Initial height: The height between the foundation upper soil surface and the foundation layer touching the wall external front face. It actually
represents the foundation depth. 

Initial length: It indicates the horizon platform length that expands by the left of the wall. It can be null.
Inclination: The counterclockwise inclination of the foundation upper layer.

The foundation may consist of a maximum of three different soil layers. The program considers these layers as horizontal planes.
For each layer the user shall provide the depth (Initial height) of the soil interface and the physical characteristics of the soil layer below it.

The foundation general data (Foundation set up...) are separated in three groups:

Soil profile
The geometric characteristics of the soil profile to the left of the gabion wall are input in the following group:

Initial height: The height between the foundation upper soil surface and the foundation layer touching the wall external front face. It actually
represents the foundation depth. 

Initial length: It indicates the horizon platform length that expands by the left of the wall. It can be null.
Inclination: The counterclockwise inclination of the foundation upper layer.

The Foundation menu contains options that produce data windows to specify the 
structure foundation characteristics and the soil in front of the wall. The  foundation 
consists of one or more soil types in horizontal layers below the base of the wall. 
The water level can be specified in the foundation. The options for this menu are:

10. Foundation

continue
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10.1 Foundation data

Soil Properties

The main soil data which compounds the foundation soil are shown in this group. If the foundation is compound of different soil layers, these
are as soil properties situated right under the top surface:

Additional data

Maximun allowable press: The maximum allowable pressure 
on the foundation. If this value is 
not provided, the program will 
compute it using the data relevant 
to the soil layer below the 
foundation upper layer.

Water table height: The depth of the water level flowing
through the downhill soil profile.
If the user types in a positive value, 
it means that the structure is 
partially submerged. If this field is
not filled in, the program will not 
consider the phreatic surface 
flowing through the foundation.

Additional data

Maximun allowable press: The maximum allowable pressure 
on the foundation. If this value is 
not provided, the program will 
compute it using the data relevant 
to the soil layer below the 
foundation upper layer.

Water table height: The depth of the water level flowing
through the downhill soil profile.
If the user types in a positive value, 
it means that the structure is 
partially submerged. If this field is
not filled in, the program will not 
consider the phreatic surface 
flowing through the foundation.

Unit weight: The unit weight of the soil
surface below the foundation
soil profile.

Friction angle: The value of the internal friction
angle below the foundation 
soil profile.

Cohesion: The cohesion of the soil 
surface below the foundation 
soil profile.

Unit weight: The unit weight of the soil
surface below the foundation
soil profile.

Friction angle: The value of the internal friction
angle below the foundation 
soil profile.

Cohesion: The cohesion of the soil 
surface below the foundation 
soil profile.

10. Foundation
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Foundation layers data are separated into two groups:

Geometry of the layer

In this group, the geometrical characteristics of any additional layer of the foundation are input. By selecting this option the following data must 
be provided:

Initial height (depth):  The thickness of the additional layer of the foundation referred to the base of the wall. The foundation layers all have a
horizontal orientation.

10.2 Data of additional foundation layers

Soil properties

Data of the soil which compounds the layer are provided in this group:

Unit weight: The unit weight of the soil layer below the additional layer.
Friction angle: The internal friction angle of the additional soil layer.
Cohesion: The cohesion of the additional soil layer.

10. Foundation
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Surcharge loads on the soi retainig structure occur very often. These loads develop from several sources, such as compacted fills, vehicular 
traffic, buildings, etc..  These loadings cause an increase in the thrust against the structure. These loads can be distributed uniformly behind the 
structure or to lines parallel with the structure (point loads). The direction of these loads is always vertically pointing downwards. The GawacWin 
program can consider external loads acting either on the backfill or on the top of the gabion wall.

In addition to external loadings, seismic actions in the form of acceleration rates can be specified acting in both horizontal and vertical directions. 

According to the limit equilibrium method, the portion of the surcharge load  acting on the soil wedge must be considered during active and 
passive thrust calculations.
By selecting the option Loads on the main menu, the user may enter the following submenus:

11. Loads
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Vertical external loadings applied over the top surface of backfill can be specified. These loadings increase the active thrust over the structure.
These loads can come in two types:

Distributed on backfill

They are loadings uniformely distributed over the backfill. Different loadings can be specified to each stretch. The program will require the user 
to type in the following data:
1st Load: The magnitude of the distributed surcharge load acting on the first stretch of the uphill soil surface.
2nd load: The magnitude of the distributed surcharge load acting on the second stretch of the uphill soil surface.

11.1 Loads on backfill

11. Loads

continue
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Lines (Point) loads on backfill

The user can specify up to three point loads acting on the backfill.
This option, when selected, requires the user to type in the following data for each point load:

Load value:` The magnitude of the point load applied on the external 
profile.

Offset: The horizontal distance between the point of application of 
the point load and the  far right of the top gabion layer starting
from the first, the user must fill in all data fields corresponding 
to the existing surcharge loads. If there are less than three 
point loads, the remaining data field must not be filled in.

11.1 Loads on backfill

trocar

11. Loads
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External vertical loadings can be specified and applied over the top of the gabions wall. These loadings can come in two types: 

Line (Point) loads on the wall

By selecting this option, the user can specify the presence of a point load acting 
upon the last gabion layer, typing in the following data:

Load: The magnitude of the point load applied on the wall;
Offset: The horizontal distance between the point of application of the

point load and  the upper right corner of the gabion layer.

Uniform load on the wall

The user can specify the presence
of a distributed surcharge load 
acting on the upper gabion layer.
If this option has been selected by
the user, a window will appear 
requiring the user to specify the 
load's magnitude.

Uniform load on the wall

The user can specify the presence
of a distributed surcharge load 
acting on the upper gabion layer.
If this option has been selected by
the user, a window will appear 
requiring the user to specify the 
load's magnitude.

11.2 Loads on wall

11. Loads



2
9

GawacWinGawacWin ®

By selecting this option a window will appear requiring the user to specify the Horizontal and Vertical coefficients of acceleration due to the 
seismic action.

During an earthquake, the active thrust can increase due to the horizontal and vertical acceleration of the ground. These accelerations induce  
inertia forces to appear in the vertical and horizontal direction. These forces as well must be considered in the force equilibrium.

These accelerations are usually expressed as a function of the gravity acceleration g and of the local seismic risks. Therefore the inertia forces
will be calculated as components of the weight of the soil wedge W.

where Ch and Cv are the horizontal and vertical coefficients of acceleration..

The program allows the action of the earthquake on the soil/structure to be identified by the user. This action is indicated by the coefficient of
horizontal and vertical acceleration. These coefficients represent the values that must be multiplied by gravity acceleration and applied on the 
soil or gabions. These seismic values of acceleration coefficients are generally imposed by codes and local patterns and depend on the local
earthquake risk.

11.3 Seismic action

11. Loads
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To conduct the external and internal stability analysis of the structure, the Analysis menu is used.  Stability analysis can be performed against 
liding along the foundation, against wall overtuning, against base soil rupture (evaluating the normal pressures acting below the base of the 
abion wall), against the rupture between each gabion layer interface, and against the global rupture along any surface surrounding the wall. This 
menu is selected after all input data has been entered and the user wants to start the stability analysis. The options available are

When choosing the option All from the menu of Analysis, the GawacWin program performs in sequence the analysis of sliding,
overturning, foundation pressures, internal stresses and overall stability. Following the analysis, the user is required to input the name of 
the project and  a final report is shown.

This command can also be activated using the tool bar.

12.1 All the analysis

12. Analysis
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One of the stability analyses performed by the GawacWin is the stability check against sliding along the base.

Before the analysis, the program checks for correctness of the input data. If incorrect, a window will display prompting the useer of the errors.
If correct, the active thrust is calculated and the following results appear on screen.  By activating the option Show rup. surfaces the user can 
visually follow this process on the screen as the program displays the failure surfaces analyzed.

- the position of the application surface of active thrust
- the value, direction and application point of active thrust
- the value, direction and application point of available passive thrust
- the structure proper weight and the applied loadings on it
- the reaction forces (normal and tangential under the base)
- the available resistance along the base

The safety factor against sliding is determined as the ratio between the available resistance and the driving forces. The available resistance is 
the sum of available shear forces along the base and the passive thrust component. The driving force is given by the thrust component acting 
toward the sliding.

12.2 Check against the sliding

12. Analysis
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The stability check against overturning is performed in the same manner as the  sliding analysis. In addition it determines:

• moments of the horizontal and vertical the components of active thrust
• passive thrust moment 
• moment of structure proper weight
• moment of other external loadings applied on the structure

Once the program has checked the input data, it calculates the active and passive
thrusts are calculated.  The program will check the moment equilibrium of all forces
acting on the wall and will show the following results in a new window::

Active (overturning) moment:
the value of the overtuning moment with respect to toe of the wall;

Restoring moment:
the sum of the moments of the passive thrust, the weight of the retaining structure, and the possible loads acting on the wall;

Safety factor:
the safety factor against overturning is determined as the ratio between the available resistance and the driving moments. The available  
resistance is the sum of weight of the structure and the passive thrust component. The driving force is given by the thrust component acting 
toward the overturning.

12.3 Check against overtuning

12. Analysis
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The acting pressure values over the foundation must be compared with the acceptable pressure. If this pressure is not provided by the user, a
value is determined by the program utilizing the soil foundation data. Only the upper most layer of foundation soil is considered for this 
calculation. If there are more than one soil layer on this foundation it is pertinent that the user verify if this pressure is accetable.

Once the analysis is complete, the following results will appear:

Left side - Stress outer foundation: The value of the normal pressure acting under the outer left edge of the base of the wall;
Rigth side - Stress inner foundation: The value of the normal pressure acting under the inner right edge of the base of the wall;
Maximum allowable pressure: The maximum allowable normal pressure acting on the foundation.

The program will show the input value provided by the user or the value calculated as stated 
above.

The GawacWin program determines the normal pressures acting on the structure's 
foundation. Strength values for the soil and the pressure applied and its application
are determined.  If the point of application of the normal force acting under the base  
of the wall is located outsid e the medium third of the base, the program will consider  
only one portion of the base of the wall for the distribution of the normal force.
For this case the user is warned that the base has not been entirely used.

The GawacWin program determines the normal pressures acting on the structure's 
foundation. Strength values for the soil and the pressure applied and its application
are determined.  If the point of application of the normal force acting under the base  
of the wall is located outsid e the medium third of the base, the program will consider  
only one portion of the base of the wall for the distribution of the normal force.
For this case the user is warned that the base has not been entirely used.12.4 Check against bearing

12. Analysis



3
4

GawacWinGawacWin ®

This analysis allows the user to determine the stresses acting between gabion layers. 
By entering this option, a window where the user has to specify the gabion layer number 
for which the program will analyze. The gabion layers are numbered progressively 
starting from the bottom to the top of the wall.
Using the internal stress analysis, the stresses along each gabion layer are determined,
in the same manner as the Foundation pressures analysis.

This analysis allows the user to determine the stresses acting between gabion layers. 
By entering this option, a window where the user has to specify the gabion layer number 
for which the program will analyze. The gabion layers are numbered progressively 
starting from the bottom to the top of the wall.
Using the internal stress analysis, the stresses along each gabion layer are determined,
in the same manner as the Foundation pressures analysis.

Selecting the Analysis Menu, the GawacWin program will request which layers are to
be analyzed. The program will conduct the analysis on the layer specified. 
If the user selects ALL and then OK without defining a number, the program will 
analyze all gabion layers and provide the calculation results.

Once the force and moment equilibrium has been determined, a window, showing the 
following results for each layer, will appear on the screen:

12.5 Check against internal 
stresses on the wall

Height: Total height of the thrust surface considered for the calculation of the active thrust acting on the analyzed 
gabion layer;

Normal force: Value of the normal force acting on the analyzed gabion layer;
Shear force: Value of the tangential force acting on the gabion layer; 
Total moment: Sum of the moments of the active thrust, the unit weight and the surcharge loads acting on the wall;
Maximum normal stress: Maximum normal stress acting on the gabion layer;
Allowable: Value of the allowable normal stress acting on the gabion layer;
Maximum shear stress: Value of the maximum shear stress acting on the analyzed gabion layer;
Allowable: Value of the allowable shear stress acting on the gabion layer.

12. Analysis
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The GawacWin program uses the Bishop method to conduct the soil-wall overall stability check, analyzing circular failure surfaces which evelop 
around the structure.
Furthermore it will automatically search for the most critical failure surface (the surface with the lowest safety factor against the structure failure) 
using the Simplex method which consists of searching for the minimum of an equation formed by more than one variable. 
If this menu option is selected, the GawacWin program shows a window of data where the user must indicate:

Left offset
Initial distance leftwards: The horizontal distance between the initiation point of the initial trial surface and its point of termination located

on the left lower edge of the base of the wall. If this value is not provided by the user, it will be automatically 
assumed by the program;

Depth offset
Initial depth: It indicates a point under the base of the wall where the first trial surface shall pass through. If this value is not 

provided by the user, the program will consider it null;
Right offset
Initial distance rightwards: The horizontal distance between the point of termination of the initial trial surface, located at the toe of the 

structure, and the top of the wall (uphill soil surface).
If this value is not provided, it will be automatically assumed by the program;

Maximum depth allowable: The maximum admissible depth of the soil surface where the program will search for the critical failure surface; 
if this value is not given, no depth limit will be considered;

Autosearch
Automatic search: When this chjoice is selected, the program will automatically search for the most critical failure surface. 

If the user does not select this option the program will only examine the initial trial circular surface.

12.6 Check of overall stability

12. Analysis
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Following the complete data input, press the OK button to run the overall stability analysis. If automatic search was selected, the program will 
analyze all failure surfaces and display them on the screen.  If the user wishes to interrupt this search, press CANCEL.  At the end of the 
stability analysis, the program will provide the user with the following output data:

Center of arch X: The coordinate X of the center point of the failure circle for  which the program has calculated the safety coefficient;
Center of arch Y: The coordinate Y of the center point of the failure circle;
Radius: The radius of the failure surface;
Safety factor: The safety coefficient against overall rupture.

12. Analysis

12.6 Check of overall stability
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12.7 Report

Following the complettion of the stability analysis, a report of the problem data, calculations, and results may be printed. 
Selecting Report from the Analysis menu, activates a window requesting the following data:

Project name: This alphanumeric field is for the user to input the name of the project. The project's name 
can consist of  a maximum of 30 letters and will be printed on the report heading.

The user may choose to print either a Complete or Reduced report depending on the option selected in the Analysis sub
menu in the Options menu. The Complete reoprt consist of a 4 page report and a 1 page summary and the Reduced report 
consist of only a 3 page report. After selecting the project title, each page of the report may be viewed on screen. The 
button Next shows the following page, the button Previous shows the prior page and the button Print drives the printing
dialogue where the printer selection and the pages to be printed can be done.

The program will print only the analysis required by the user.  If the user has not performed all the stability analyses, the 
spaces on the report for these analyses will be left blank.

12. Analysis



3
8

GawacWinGawacWin ®

The submenu Options allows the user to choose the global parameters for the programs general operation. These options include:

The GawacWin 1.0 program allows three different unit systems. The user may selct a different set of units any time during the program 
operation. The unit system is selected in the Options menu under the submenu Units. The table below shows for each unit system the unit of 
measure for each parameter.

The GawacWin 1.0 program can be configured to express its 
messages in six different languages. The language configuration 
may be changed at any time, by using the submenu Language
from the Options menu. The languages available are:

The GawacWin 1.0 program can be configured to express its 
messages in six different languages. The language configuration 
may be changed at any time, by using the submenu Language
from the Options menu. The languages available are:

13.1 Units

13.2 Language

13. Options

System Length Strength Tension Specific Weight
Technical m tf/m tf/m2 tf/m3

International m kN/m kPa kN/m3

Imperial ft. lb/ft lb/ft2 lb/ft3
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The analysis options are set in the submenu Analysis within the Options menu. Several parameters for which the program will perform the 
analysis may be selected:

Show rupture surfaces: when this item is selected, the rupture surfaces which are analyzed by the program are shown on the screen.
This will make the analysis slower.

Allow tension cracks: when this option is selected, the active thrust calculation is performed, considering that the cracks that  
occur in cohesive soils will be filled with water. This consideration increases the thrust value and therefore 
is recommended.

Passive thrust reduction: This option allows the
ser to reduce the amount of the passive resistance 
used during the sliding analysis, in percentage.

Report:The program issues a report 
following the analysis. The user may 
choose either a Complete (5 pgs.) or 
Reduced (3 pgs.) report.

13.3 Analysis options

13. Options
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The View menu gives several options for screen visualization of the analysed problem. The drawing can be increased
and decreased in scale and relocated within the viewing window or the entire viewing window may be modified.

Options are presented on this submenu:

Shortcut Keys}
•Zoom In (enlarges the drawing size)
•Zoom Out (reduces the drawing size)
•Left (moves the drawing to the left)
•Right (moves the drawing to the right)
•Up (moves the drawing upward) 
•Down (moves the drawing downwards)

14. View
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Open the disc file

Save the file on the disc

Increase the drawing scale

Decrease the drawing scale

Move the drawing left

Move the drawing right

Move the drawing up

Move the drawing down

Perform all the analyses

Right below the program Main menu, on the main screen, a tool bar is displayed with buttons that drive the most 
commonly used commands.  
To activate these commands, press the mouse button when the indicator is on the button. These buttons are:

15. Tool bar
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The GawacWin program allows the user to utilize the mouse for on screen editing of the wall 
geometry. Simply place the mouse indicator over the element to alter and press the left button. This 
enables the element selection which brings small graphic symbols into sight called "grips".
At the same time, data about the selected element, appears on the left part of the tool bar. To alter the 
element, move the grips to the desired location. The data in the tool bar will have been automatically 
modified, reflecting the change.   In addition, double clicking the mouse produces the Wall Setup 
window that allows the user to make numeric changes. Right clicking the mouse, prompts a menu that 
permits the following options:

• Add layer: Add a new layer of gabions to the wall top 
• Insert layer: Insert a new layer over the selected layer
• Delete layer: Take out a selected layer of gabions
• Modify layer: Modify the selected layer of gabions
• Edit layer...: Opens the window of the wall general data

The first three options can be driven when the layer of gabions is selected by pressing the keys [Ins], [Shift]+[Ins] and [Del], respectivily.

The keys [Ins] and [Del] also drive the equivalent commands when the backfill layers or the foundation layers are selected.

The command to click and drag is also available for these elements.

The key [Del] can also be used when the phreatic surface or the level is selected.  In this case the element is excluded.

16. Using the mouse
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The commands for handling the files on disc, as well as the drawing printed on the screen are selected 
from the menu File. These options are:

•Start a new wall of gabions to be analyzed.
•To load the data and the cross-section pertinent to a selected file.
•This option is used to save or update the project data on a file.
•Recording data from a new file on a disc.

•To record the drawing of the wall which is shown on the screen.
The following format can be chosen: autoCad-DXF, Windows MetaFile
(wmf),  Windows Enhanced MetaFile (.emf) and Windows Bitmap (.bmp).

•To print the drawing shown on screen.
•End the GawacWin program.

17. File
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